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About Microsoft Office 2007 
The Microsoft Office 2007 suite of applications represents a significant change in the way users 
interact with the software. The redesigned user interface represents the most significant change 
since the Office 95 version was introduced more than a decade ago. 

This handout provides a summary of the new features in the user interface that are common to 
most of the applications in the suite (Word, Excel, PowerPoint, Access, and Outlook). 
Additionally, file extension differences and version compatibility management are also 
discussed. 

File Extensions and Version Compatibility 
The Microsoft Office 2007 applications now utilize four-letter file extensions to differentiate file 
types. Table 1 summarizes the new file extensions compared to previous versions. 

Table 1 - Application File Extensions 
Application Old Extension New Extension 
Access .mdb .mdbx 
Excel .xls .xlsx 
PowerPoint .ppt .pptx 
Word .doc .docx 

Files that were created in versions of Office earlier than Office 97 will not open in the 2007 
applications. Files created in applications from Office 97 and later are fully compatible with the 
2007 suite. By default, when a file created in Office 2007 is saved, it is saved with the new four-
letter file extension. Files can be saved so that they are compatible with Office 97-2003 by using 
the Save As feature in the application. 

Files saved with the Office 2007 file extensions are not backwards compatible, that is, they will 
not open in earlier versions of the application. It is possible, however, to download and install a 
free application from Microsoft called the Compatibility Pack that will allow users who do not 
have Office 2007 to open an Office 2007 file in earlier versions of Office. The Compatibility 
Pack can be found at the Microsoft Web site. 

The Office Button 
The Office Button is found in the upper left 
corner of the application window (see Figure 
1). Clicking the Office Button will open the 
Office Button Menu (see Figure 2) that 
contains features that are usually common 
among the applications of the Office Suite such 
as New, Open, Save, Save As, and Print. 

  
Figure 2 - Office Button MenuFigure 1 - The Office Button 
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The Ribbon 
The Ribbon is the most striking new feature of the user interface in the Office 2007 applications. 
All Office applications use a Ribbon. The Ribbon is divided into a series of tabs, and each tab is 
divided into a series of groups (see Figure 3). The Ribbon replaces the menu and toolbar 
structures that were found in previous versions of Office. By eliminating these structures, users 
are presented with multiple groups of commands that are grouped by function. Groups and tabs 
are not customizable. If desired, the Ribbon can be minimized by right-clicking anywhere on the 
Ribbon and selecting the   option. When minimized, only the tabs will be 
visible. 

  
Figure 3 - Example of a Ribbon with the Home Tab Active 

CONTEXTUAL TABS 
Contextual tabs are tabs on the Ribbon that only appear when specific objects are selected. 
Examples of such objects include charts, tables, and images. Figure 4 is an example of a set of 
contextual tabs. The Design and Layout tabs would normally not appear on the ribbon. They are 
present only when a table is selected, which activates the Table Tools contextual tabs. Contextual 
tabs can be identified by the coloration of the identifier that appears above the other tabs. In 
Figure 4, the yellow shading identifies the contextual tabs. 

 
Figure 4 - Example of Contextual Tabs 

The Quick Access Toolbar 
The Quick Access Toolbar  is located on the right side of the Office Button above 
the Ribbon. The Quick Access Toolbar is customizable, meaning that the user can add or 
remove specific commands that will make them readily accessible instead of scrolling through 
the tab structure. Customization options are 
available by clicking the Customize Quick 
Access Toolbar drop-down arrow  at the 
right edge of the toolbar and selecting from 
the options available on the drop-down 
menu (see Figure 5). Selecting the 

  item will open the Word 
Options dialog box and provide additional 
customization commands (see Figure 6). 

 
Figure 5 - Customize Quick Access Toolbar Drop-

Down Menu
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Figure 6 - Word Options Dialog Box (Customize Options) 

The Mini Toolbar 
The Mini toolbar is a semitransparent toolbar that appears whenever text is selected. The toolbar 
is a collection of commands to help the user manage fonts, font styles, font sizing, alignment, 
text color, fill color, indentation levels, and bullet features (see Figure 7). When text is selected, 
the Mini toolbar will appear as a semitransparent object. To activate it, place the mouse cursor 
over the toolbar. To deactivate it, click anywhere in the application window.

 
Figure 7 - The Mini Toolbar 

 
Figure 8 - Mini Toolbar/Pop-Up Menu Combination 
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Super Tooltips 
Tooltips were originally used in Office applications with toolbars. Their purpose was to identify 
the buttons on the toolbars in case the user did not recognize the function provided by the button. 
Users could activate a tooltip by hovering the mouse over the button. Super tooltips function the 
same way as the older tooltips except that they provide more information. Figure 9 is an example 
of a super tooltip. Super tooltips often (but not always) provide a graphic image of the function, 
in addition to a more expanded explanation on the capabilities and limitations of the function. 

 
Figure 9 - Example of a Super Tooltip 

Dialog Box Launchers 
Dialog Box Launchers   are shortcut buttons located in the lower right corner of a group on 
the Ribbon. They are used to open dialog boxes that contain more options for the user to choose 
from. Most of the dialog boxes are the same as in previous versions of Office. Examples include 
the Font, Paragraph, or Page Setup dialog boxes. Not every group on the Ribbon has a dialog 
box launcher. 

The Zoom Slider 
The Zoom Slider  is a new option that replaces the magnification tool in 
previous versions of Office. The Zoom Slider is located in the lower right corner of the 
application window. The control is always present in an application, except in Access, when it is 
only present when a report object is open. The Plus and Minus buttons on the control magnify or 

shrink the view in increments of 10%. The Slider Control  allows the user to magnify or 
shrink the view in increments of 1%. 

Quick Style Galleries 
Quick Styles are the same as the styles that were available in the Styles and Formatting task 
pane in previous versions of Office. They are displayed in galleries on the Ribbon which makes 
them readily accessible. Figure 10 is an example of a Quick Style Gallery as it appears in 
collapsed form in the Styles group on the Word Ribbon. The Quick Styles Gallery can be 
expanded (see Figure 11) by clicking the More button . As in previous versions of Office, 
styles can be modified. Right-clicking on a style opens a pop-up menu (see Figure 12). Selecting 
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the Modify… option opens the Modify Style dialog box (see Figure 13) where style attributes can 
be changed. 

 
Figure 10 - Styles Group on the Word Ribbon 

 
Figure 11 - Example of Expanded Quick Style Gallery

  
Figure 12 - Style Pop-Up Menu Figure 13 - Modify Style Dialog Box 

Live Preview 
The Live Preview feature allows a user to see the effect of formatting changes without having to 
apply them. When a portion of text is selected, Live Preview automatically previews the text 
with the new formatting options as the mouse is moved over buttons or styles on the Ribbon.  
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Live Preview does not make any permanent changes to a document. Rather, like its name 
suggests, it simply allows you to preview changes. 

SmartArt 
SmartArt is a new feature in Office 2007. SmartArt is a visual representation of information and 
ideas that combines text and graphics so that information can be shown in a more visually 
enhancing manner. Figure 14 is an example of SmartArt. When the SmartArt graphic is placed 
on the slide, text can be automatically entered. The advantage to using SmartArt is that the user 
does not have to draw any of the graphic shapes. They are automatically created when the 
graphic is selected.

 
Figure 14 - Example of SmartArt 

 
Figure 15 - Choose a SmartArt Graphic Dialog Box 

To incorporate a SmartArt graphic onto a slide: 
1. Select the Insert tab on the Ribbon. 
2. Click the SmartArt button in the Illustrations group. The Choose a SmartArt Graphic 

dialog box opens (see Figure 15).  
3. Select the category in the left column of the dialog box; select the graphic in the List 

section of the dialog box. A description is provided in the preview pane on the right side 
of the dialog box (see Figure 15). 

4. After the graphic is selected, click the OK button. Text can then be entered by clicking in 
any part of the graphic where “[Text]” appears. 

NOTE: Text can also be entered by clicking the Expand/Collapse button  on the left edge of the 
graphic and opening the Type your text here dialog box (see Figure 17). Click the Close button   
when finished and the text will automatically appear in the graphic.
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Figure 16 - Sample Blank SmartArt Graphic 

 
Figure 17 - Type Your Text Here Dialog Box 

The SmartArt graphic can be formatted if a 
different appearance is desired. To format 
the graphic: 

1. Select the object so that the sizing 
handles are visible as in Figure 16. 

2. Right-click anywhere inside the 
object and select the  
option. The Format Shape dialog 
box opens (see Figure 18). 

3. Choose the appropriate options until 
the desired formatting effects are 
displayed by the graphic. 

4. When finished formatting the 
graphic, click the Close button. 

 
Figure 18 - Format Shape Dialog Box 

Chart Galleries 
Previous versions of Office did not allow for the creation of charts in Word documents or 
PowerPoint with the same functionality as Excel. Users were restricted to embedding an Excel 
Chart Object into a document or using the Microsoft Graph utility to create charts in applications 
other than Excel. Office 2007 now integrates the full capabilities of Excel into charts created as 
part of a Word document or a PowerPoint presentation. 

To create a chart: 
1. Select the Insert tab on the Ribbon. 
2. Click the Chart button in the Illustrations group (see Figure 19). The Insert Chart dialog 

box will open displaying all the available charts in the Chart Gallery (see Figure 20). 
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3. When the chart type is selected and the OK button has been pressed, Microsoft Excel will 
open and the user can enter data that will be directly linked to the chart. The data and 
chart attributes will be stored in the application, not as a separate Excel file. 

 
Figure 19 - Illustrations Group 

 
Figure 20 - Insert Chart Dialog Box 

CHART TOOLS CONTEXTUAL TABS 
The three Chart Tools contextual tabs contain the tools necessary to modify and enhance the 
chart. Contextual tabs are not visible or activated until the chart is activated. Figure 21, Figure 
22, and Figure 23 identify all of the groups in each of the contextual tabs. All of the Chart Tools 
available in Excel are now also available in Word and PowerPoint. 

 

 
Figure 21 - Design Contextual Tab Groups 

 

 
Figure 22 - Layout Contextual Tab Groups
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Figure 23 - Format Contextual Tab Groups 

Setting Application Options 
Office 2007 applications have selectable options and customizable features just like previous 
versions. The steps to access the application options are similar for all Office applications. The 
following example accesses the Word 2007 options. 

To access the application options: 
1. Click the Office Button to view the Office Button Menu and Options (see Figure 24). 
2. Select the  feature in the lower right corner. The application Options dialog box 

opens (see Figure 25).  
3. Select the category from the menu on the left side of the dialog box, and then select the 

options or features from the appropriate section. 
4. To apply selected options and features, click the OK button to close the dialog box. 

 
Figure 24 - Office Button Menu and Options 
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NOTE: The Push Pin icon  that appears in the Recent menu can be used to “pin” a file to the list of 
recent files. This means that it will not disappear from the list until it is “unpinned.” When a file is pinned 
to the list, the shape of the icon changes appearance to . 

 
Figure 25 - Application Options Dialog Box 

Managing File Properties 
Unlike previous versions, Office 2007 allows file properties to be displayed and edited in the 
user interface while the document is in edit mode. When opened, the Properties Panel appears 
just below the Ribbon (see Figure 26). The Panel will remain open and accessible for editing file 
properties until it is closed. To open the Panel, click the Office Button, select the  option, 
and then select  from the menu. 

 
Figure 26 - File Properties Panel 

File properties can be customized using the same dialog box that was available in previous 
versions of Office. To open the Properties dialog box, click the Document Properties drop-
down arrow in the Properties Panel and select the Advanced Properties option (see Figure 27). 
The Advanced Properties dialog box will open (see Figure 28). The tabs on the dialog box 
contain information and features that the user can access or even modify..
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Figure 27 - Accessing the Properties Dialog Box 

 
Figure 28 - Properties Dialog Box 

The Document Inspector 
Another new feature in Microsoft Office 2007 applications is the Document Inspector feature. 
Files may sometimes contain hidden or personal information that a user may be unaware of, or 
does not want to share with others if copies of the file will be distributed. Personal information 
can also become embedded in the form of metadata when file properties are set. The Document 
Inspector will identify any potential information that a user may want removed before 
distributing a file and give the user the option to remove it.  

To use the Document Inspector: 
1. Click the Office Button. 
2. Select the  option. 
3. Select the  option. The Document Inspector dialog box opens (see Figure 

29). 
4. Users are presented with six categories of information that the Document Inspector will 

search for. Each of the categories can be either selected or deselected by the user with the 
associated check boxes. 

5. When the categories have been selected, click the Inspect button. 
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Figure 29 - Document Inspector Dialog Box 

6. When the Document Inspector completes its search, the Document Inspector Results 
dialog box will open (see Figure 30).  

7. If any potential personal information is found within the document, the user can choose 
to ignore it or eliminate it by clicking the Remove All button. 

8. The user can re-inspect the document by clicking the Reinspect button, or, if no further 
actions are needed, click the Close button. 

 
Figure 30 - Document Inspector Results Dialog Box 

The Compatibility Checker 
A new feature in several of the Microsoft Office 2007 applications is the Compatibility Checker. 
The Compatibility Checker will inspect workbooks, documents, or presentations created in an 
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Office  2007 application to see if the worksheets contain objects such as SmartArt that are 
incompatible with earlier versions. The following example shows a compatibility check from 
Excel 2007. Other applications run the Checker in a similar manner.

To run the Compatibility Checker: 

 

1. Click the Office Button. 
2. Select the  option. 
3. Select the Run Compatibility Checker 

option. The Microsoft Office Excel 
Compatibility Checker dialog box opens 
(see Figure 31). Any incompatible items 
will be identified in the dialog box. 

4. Click the OK button to close the dialog 
box. 

NOTE: If no incompatible items are identified 
in the file, the dialog box will still open and 
indicate that no incompatible items were found. 

Figure 31 - Microsoft Office Excel Compatibility 
Checker Dialog Box 

By default, Excel and other Office 2007 applications will check the backwards compatibility of 
any presentation, document, or worksheet when it is saved in the Office 97-2003 format. If no 
incompatible items are found, the Microsoft Office Compatibility Checker dialog box will not 
open. If an incompatible item is identified and the user proceeds to save the item, the 
incompatible item will be degraded so that the file will open in an earlier version. For example, 
SmartArt objects will be converted to non-editable images that will open in the earlier version. 
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